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Abstract

This deliverable is the user manual for the INTO-CPS tool chain, an update
of deliverable D4.2a [BLL+15]. It is targeted at those wishing to make use
of the INTO-CPS technology to design and validate cyber-physical systems.
As a user manual, this deliverable is concerned with those aspects of the tool
chain relevant to end-users, so it is necessarily high-level. Other deliverables
discuss �ner details of individual components, including theoretical founda-
tions and software design decisions. Readers interested in this perspective on
the tool chain should consult deliverables D4.2b [PBLG16], D4.2c [BQ16],
D4.2d [LNH+16], D5.2a [PLM16], D5.2b [BLM16], D5.2c [BHPG16], D5.2d
[Gam16], D2.2a [ACM+16], D2.2b [FCC+16], D2.2c [CFTW16] and D2.2d
[CW16].
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1 Introduction

This deliverable is the user manual for the INTO-CPS tool chain. The
tool chain supports a model-based development and veri�cation approach
for Cyber-Physical Systems (CPSs). Development of CPSs with the INTO-
CPS technology proceeds with the development of constituent models us-
ing established and mature modelling tools. Development also bene�ts from
support for Design Space Exploration (DSE). The analysis phase is primarily
based on co-simulation of heterogeneous models compliant with version 2.0 of
the Functional-Mockup Interface (FMI) standard for co-simulation [Blo14].
Other veri�cation features supported by the tool chain include hardware-
and software-in-the-loop (HiL and SiL) simulation and model-based test-
ing. Presently there is limited support for Linear Temporal Logic model
checking of discrete models, with further model checking support being de-
veloped.

All INTO-CPS tools can be obtained from

http://into-cps.github.io

This is the primary source of information and help for users of the INTO-
CPS tool chain. The structure of the website follows the natural �ow of CPS
development with INTO-CPS, and serves as a natural aid in getting started
with the technology. In case access to the individual tools is required, pointers
to each are also provided.

Please note: This user manual assumes that the reader has a good under-
standing of the FMI standard. The reader is therefore strongly encouraged to
become familiar with Section 2 of deliverable 4.1d [LLW+15] for background,
concepts and terminology related to FMI.

The rest of this manual is structured as follows:

• Section 2 provides an overview of the di�erent features and components
of the INTO-CPS tool chain.

• Section 3 explains the relevant parts of the Modelio SysML modelling
tool.

• Section 4 explains the di�erent features of the main user interface of
the INTO-CPS tool chain, called the INTO-CPS Application.

• Section 5 describes the separate modelling and simulation tools used in
elaborating and verifying the di�erent constituent models of a multi-
model.
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• Design Space Exploration (DSE) for INTO-CPS multi-models is pre-
sented in Section 6.

• Section 7 describes model-based test automation and model checking
in the INTO-CPS context.

• Section 8 provides a short overview of code generation in the INTO-
CPS context.

• The appendices are structured as follows:

� Appendix A lists the acronyms used throughout this deliverable.

� Appendix B gives background information on the individual tools
making up the INTO-CPS tool chain.

� Appendix C describes how the individual tools can be obtained.

� Appendix D gives background information on the various princi-
ples underlying the INTO-CPS tool chain.

2 Overview of the INTO-CPS Tool Chain

The INTO-CPS tool chain consists of several special-purpose tools from a
number of di�erent providers. Note that it is an open tool chain so it is
possible to incorporate other tools that also support the FMI standard for
co-simulation and we have already tested this with numerous external tools
(both commercial as well as open-source tools). The constituent tools are
dedicated to the di�erent phases of co-simulation activities. They are dis-
cussed individually through the course of this manual. An overview of the
tool chain is shown in Figure 1. The main interface to an INTO-CPS co-
simulation activity is the INTO-CPS Application. This is where the user
can design co-simulations from scratch, assemble them using existing FMUs
and con�gure how simulations are executed. The result is a co-simulation
multi-model.

The design of a multi-model is carried out visually using the Modelio SysML
tool, in accordance with the SysML/INTO-CPS pro�le described in D2.2a
[ACM+16]. Here one can either design a multi-model from scratch by specify-
ing the characteristics and connection topology of Functional Mockup Units
(FMUs) yet to be developed, or import existing FMUs so that the connections
between them may be laid out visually. The result is a SysML multi-model of
the entire co-simulation, expressed in the SysML/INTO-CPS pro�le. In the

8



D4.3a - INTO-CPS Tool Chain User Manual (Public)

Modelio

Model Description

Overture 20-sim OpenModelica
RT-Tester

FMU FMU FMU FMU

E
x
p
or
t
p
ar
t

Im
po
rt

Im
p
or
t Im

port

Import

E
x
p
or
t

E
x
p
or
t

E
xp
or
t

E
xp
or
t

F
M
U
Im
p
or
t

U
M
L
M
od
el
E
xc
ha
ng
e

INTO-CPS
App

DSE COE

F
M
U
M
od
el
C
he
ck

C
o-sim

M
odel C

heck

Co-sim
con�g

Optimal
co-sim
con�g

Co-sim
con�g

Co-sim
con�g

Live Update

Obtain co-sim con�g

Figure 1: Overview of the structure of the INTO-CPS tool chain.

former case, where no FMUs exist yet, a number of modelDescription
.xml �les are generated from this multi-model which serve as the starting
point for constituent model construction inside each of the individual simu-
lation tools, leading to the eventual FMUs.

Once a multi-model has been designed and populated with concrete FMUs,
the Co-simulation Orchestration Engine (COE) can be invoked to execute
the co-simulation. The COE controls all the individual FMUs in order to
carry out the co-simulation. In the case of tool-wrapper FMUs, the model
inside each FMU is simulated by its corresponding simulation tool. The tools
involved are Overture [LBF+10], 20-sim [Con13] and OpenModelica [Lin15].
RT-Tester is not under the direct control of the COE at co-simulation time, as
its purpose is to carry out testing and model checking rather than simulation.
The user can control a co-simulation, for instance by running it with di�erent
simulation parameter values and observing the e�ect of the di�erent values
on the co-simulation outcome.

Alternatively, the user has the option of exploring optimal simulation pa-
rameter values by entering a Design Space Exploration phase. In this mode,
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ranges are de�ned for various parameters which are explored, in an intel-
ligent way, by a design space exploration engine that searches for optimal
parameter values based on de�ned optimization conditions. This engine in-
teracts directly with the COE and itself controls the conditions under which
the co-simulation is executed.

3 Modelio and SysML for INTO-CPS

The INTO-CPS tool chain supports a model-based approach to the develop-
ment and validation of CPS. The Modelio tool and its SysML/INTO-CPS
pro�le extension provide the diagramming starting point. This section de-
scribes the Modelio extension that provides INTO-CPS-speci�c modelling
functionality to the SysML modelling approach.

The INTO-CPS extension module is based on the Modelio SysML extension
module, and extends it in order to ful�ll INTO-CPS modelling requirements
and needs. Figure 2 shows an example of a simple INTO-CPS Architecture
Structure Diagram under Modelio. This diagram shows a System, named

Figure 2: Example INTO-CPS multi-model.

�System�1, composed of two EComponents of kind Subsystem, named �Sub-
System�2. These Subsystems have an internal Variable called �variable� of
type String and expose two FlowPorts named �portIn� and �portOut�. The
type of data going through these ports is respectively de�ned by types In

1An abstract description of an INTO-CPS multi-model.
2Abstract descriptions of INTO-CPS constituent models.
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and Out of kind StrtType. More details on the SysML/INTO-CPS pro�le
can be found in deliverable D2.2a [ACM+16].

Figure 3 illustrates the main graphical interface after Modelio and the INTO-
CPS extension have been installed. Of all the panes, the following three are

Figure 3: Modelio for INTO-CPS.

most useful in the INTO-CPS context.

1. The Modelio model browser, which lists all the elements of your model
in tree form.

2. The diagram editor, which allows you to create INTO-CPS design ar-
chitectures and connection diagrams.

3. The INTO-CPS property page, in which values for properties of INTO-
CPS subsystems are speci�ed.

3.1 Creating a New Project

In the INTO-CPSModelling work�ow described in Deliverable D3.2a [FGPP16],
the �rst step will be to create, as depicted in Figure 4, a Modelio project:

1. Launch Modelio.

2. Click on File → Create a project....

11
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Figure 4: Creating a new Modelio project.

3. Enter the name of the project.

4. Enter the description of the project.

5. If it is envisaged that the project will be connected to a Java develop-
ment work�ow in the future (unrelated to INTO-CPS), you can choose
to include the Java Designer module by selecting Java Project, other-
wise de-select this option.

6. Click on Create to create and open the project.

Once you have successfully created a Modelio project, you have to install
the Modelio extensions required for INTO-CPS modelling, i.e. both Modelio
SysML and INTO-CPS extensions, as described at

http://into-cps.github.io

If both modules have been correctly installed, you should be able to create,
under any package, an INTO-CPS Architecture Structure Diagram in order
to model the �rst subsystem of your multi-model. For that, in the Mode-

12
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lio model browser, right click on a Package element then in the INTO-CPS
entry, choose Architecture Structure Diagram as shown in Figure 5. Fig-
ure 6 represents an example of an Architecture Structure Diagram. Besides

Figure 5: Creating an Architecture Structure diagram.

creating an Architecture Structure Diagram from scratch, the INTO-CPS
extension allows the user to create it from an existing modelDescription
.xml �le. A modelDescription.xml �le is an artifact de�ned in the
FMI standard which speci�es, in XML format, the public interface of an
FMU. To import a modelDescription.xml �le,

1. Right click in the Modelio model browser on a Package element, then
in the INTO-CPS entry choose Import Model description, as shown in
Figure 7.

2. Select the desired modelDescription.xml �le in your installation
and click on Import (Figure 8).

This import command creates an Architecture Structure Diagram describing
the interface of an INTO-CPS block corresponding to the modelDescrip-
tion.xml �le imported, cf. Figure 9. Once you have created several such
blocks, either from scratch or by importing modelDescription.xml �les,
you must eventually connect instances of them in an INTO-CPS Connection
Diagram. To create an INTO-CPS Connection diagram, as for an INTO-
CPS Architecture Structure Diagram, right click on a Package element, then

13
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Figure 6: Example Architecture Structure diagram.

in the INTO-CPS entry choose Connection Diagram, as shown in Figure 10.
Figure 11 shows the result of creating such a diagram. Once you have created
all desired block instances and their ports by using the dedicated command in
the Connection Diagram palette, you will be able to model their connections
by using the connector creation command (Figure 12). At this point your
blocks have been de�ned and the connections have been set. The next step
is to simulate your multi-model using the app. For that you must �rst gen-
erate a con�guration �le from your Connection diagram. Select the desired
Connection diagram, right click on it and in the INTO-CPS entry choose
Generate con�guration, as shown in Figure 13. In the �nal step, choose a
relevant name and click on Generate.

3.2 Exporting modelDescription.xml Files

The SysML Connection diagram de�nes the components of the system and
their connections. The internals of these block instances are created in
the various modeling tools and exported as FMUs. The modeling tools
Overture, 20-sim and OpenModelica support importing the interface def-
inition (ports) of the blocks in the Connection diagram by importing a

14
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Figure 7: Importing an existing model description.

Figure 8: Model description selection.

modelDescription.xml �le containing the block name and its interface
de�nition.

Follow these steps to export a modelDescription.xml �le from Mode-
lio:

1. In Modelio, right-click on the model block in the tree.

2. Select INTO-CPS → Generate Model Description (see Figure 14).

3. Choose a �le name containing the text �modelDescription.xml� and
click Export (see Figure 15).

15
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Figure 9: Result of model description import.

Figure 10: Creating a Connection diagram.
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Figure 11: Unpopulated Connection diagram.

Figure 12: Populated Connection diagram.
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Figure 13: Generating a con�guration �le.

Figure 14: Exporting a modelDescription.xml �le.
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Figure 15: Naming the model description �le.
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4 The INTO-CPS Application

This section describes the INTO-CPS Application(here referred to as the
app), the primary gateway to the INTO-CPS tool chain. Section 4.1 gives
an introductory overview of the app. Section 4.2 describes how the app
can be used to create new INTO-CPS co-simulation projects. Section 4.3
describes how multi-models can be assembled. Section 4.4 describes how co-
simulations are con�gured, executed and visualized. Section 4.5 lists some
additional useful features of the app, while Section 4.6 describes how the
co-simulation engine itself can be started manually, for specialist use.

4.1 Introduction

The app is the front-end of the entire INTO-CPS tool chain. The app de�nes
a common INTO-CPS project and it is the easiest way to con�gure and
execute co-simulations. Certain features in the tool chain are only accessible
through the app. Those features will be explained in their own sections
of the user manual. This section introduces the app and its basic features
only.

Releases of the app can be downloaded from:

https://github.com/into-cps/intocps-ui/releases

Four variants are available:

• -darwin-x64.zip � MacOS version

• -linux-x64.zip � Linux (64 bit) version

• -win32-ia32.zip � Windows (32 bit) version

• -win32-x64.zip � Windows (64 bit) version

The app itself has no dependencies and requires no installation. Simply unzip
it and run the executable. However, certain app features require Git3 and
Java 84 to be already installed.

3https://git-scm.com/
4http://www.oracle.com/technetwork/java/javase/overview/

java8-2100321.html
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4.2 Projects

An INTO-CPS project contains all the artifacts used and produced by the
tool chain. The project artifacts are grouped into folders. You can create
as many folders as you want and they will all be displayed in the project
browser. The default set of folders for a new project, shown in Figure 16, is:

Figure 16: INTO-CPS project shown in the project browser.

Design Space Explorations Scripts and con�guration �les for performing
DSE experiments.

FMUs FMUs for the constituent models of the project.

Model Checking Con�guration �les for performing Model Checking exper-
iments.

Models Sources for the constituent models of the project.

Multi-Models The multi-models of the project, using the project FMUs.
This folder also holds con�guration �les for performing co-simulations.

SysML Sources for the SysML model that de�nes the architecture and con-
nections of the project multi-model.

Test-Data-Generation Con�guration �les for performing test data gener-
ation experiments.

In order to create a new project, select File → New Project, as shown in
Figure 17a. This opens the dialog shown in Figure 17b, where you must
choose the project name and location � the chosen location will be the root

21
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(a) New Project menu entry. (b) New Project dialog.

Figure 17: Creating a new INTO-CPS project.

(a) Import Git Project menu entry. (b) Import Git Project dialog.

Figure 18: Importing a Git project.

of the project, so you should manually create a new folder for it. To open an
existing project, select File → Open Project, then navigate to the project's
root folder and open it.

To import a project stored in the Git version control system, select File →
Import Project from Git, as shown in Figure 18a. This opens the dialog shown
in Figure 18b, where you must choose the project location and also provide
the Git URL. The project is checked out using Git, so any valid Git URL
will work. You must also have Git available in your PATH environment
variable in order for this feature to work. It is possible to import several
public example projects that show o� the various features of the INTO-CPS
tool chain. These examples are described in Deliverable D3.5 [PGP+16]. To
import an example, select File → Import Example Project, as shown in Figure
19a. This opens the dialog box shown in Figure 19b, where you must select
which example to import and a project location. The example is checked out
via Git, so you must have Git available in your path in order for this feature
to work. For both Git projects and examples, once you begin the import

22
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(a) Import Example Project menu. (b) Import Example Project dialog.

Figure 19: Importing examples.

process, a process dialog is displayed, as shown in Figure 20.

Figure 20: Progress of project imports through Git.

4.3 Multi-Models

For any given project, the app allows you to create and edit multi-models
and co-simulation con�gurations. To create a new multi-model, right click
the Multi-models node in the project browser and select New multi-model,
as shown in Figure 21. After creation, the new multi-model is automatically
opened for editing. To select an existing multi-model for editing, double-
click it. Once a multi-model is open, the multi-model view, shown in Figure
22 is displayed. The top box, Overview, displays an overview of the input
and output variables in the FMUs, as shown in Figure 23. The bottom box,
Con�guration, enables the user to con�gure the multi-model. In order to
con�gure a multi-model, it must �rst be unlocked for editing by clicking the
Edit button at the bottom of the Con�guration box. There are four main
areas dedicated to con�guring various aspects of a multi-model.

The FMUs area, shown in Figure 24, allows you to remove or add FMUs

23
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Figure 21: Creating a new multi-model.

Figure 22: Main multi-model view.

and to associate the FMUs with their �les by browsing to, or typing, the
path of the FMU �le. For each FMU �le a marker is displayed indicating
whether the FMU is supported by the app and can be used for co-simulation
on the current platform. The FMU instances area, shown in Figure 25,
allows you to create or remove FMU instances and name them. A multi-
model consists of one or more interconnected instances of various FMUs.
More than one instance may be created for a given FMU. As a convenient
work�ow shortcut, the Connections area, shown in Figure 26, allows you
to connect output variables from an FMU instance into input variables of
another:

1. Click the desired output FMU instance in the �rst column. The output
variables for the selected FMU appear in the second column.
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Figure 23: Multi-model overview.

Figure 24: FMUs con�guration.

2. Click the desired output variable in the second column. The input
instances appear in the third column.

3. Click the desired FMU input instance in the third column. The input
variables for the selected FMU appear in the fourth column.

4. Check the box for the desired input variable in the fourth column.

This facility makes it unnecessary to return to Modelio whenever small
changes must be made to the connection topology of the multi-model. The
Initial values of parameters area, shown in Figure 27, allows you to set the

25
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Figure 25: FMU instances con�guration.

Figure 26: Connections con�guration.

initial values of any parameters de�ned in the FMUs:

1. Click the desired FMU instance in the Instance Column.

2. Select the desired parameter in the Parameters dropdown box and click
Add.

3. Type the parameter value in the box that appears.

Once the multi-model con�guration is complete, click the Save button at the
bottom of the Con�guration box.

26
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(a) Parameter selection.

(b) Parameter value input.

Figure 27: Initial values of parameters con�guration.
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4.4 Co-simulations

With the INTO-CPS tool chain it is possible to distribute a co-simulation
across several computing nodes such that FMUs need not be co-located with
the COE on the same node. This capability caters to situations in which
FMUs are restricted to simulation on speci�c platforms for reasons of legacy
technology, licensing etc. In the current version of the tool chain this func-
tionality is not fully integrated with the app, and requires the user to start
the simulation procedure manually. This is discussed in Section 4.6 below.
The remainder of this section discusses standard co-simulations on a single
computing node.

To execute co-simulations of a multi-model, a co-simulation con�guration is
needed. To create a co-simulation con�guration, right click the desired multi-
model and select Create Co-Simulation Con�guration, as shown in Figure
28. After creation, the new con�guration automatically opens for editing.
To select an existing co-simulation con�guration, double-click it. Once a

Figure 28: Creating a co-simulation con�guration.

con�guration is open, the co-simulation con�guration, shown in Figure 29, is
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displayed. The top box, Con�guration, lets you con�gure the co-simulation.
The bottom box, Simulation, lets you execute the co-simulation. In order to

Figure 29: Main co-simulation con�guration view.

con�gure a co-simulation, the con�guration must �rst be unlocked for editing
by clicking the Edit button at the bottom of the Con�guration box. There
are three things to con�gure for a co-simulation, discussed next.

The top area, shown in Figure 30, allows you to select the start and end
time for the co-simulation as well as the master algorithm to be used. For

Figure 30: Start/End time and master algorithm con�guration.

every algorithm, there are con�guration parameters that can be set. These
are displayed below the top area, as shown in Figure 31. These parameters
di�er with the master algorithm chosen. The Livestream Con�guration area,
shown in Figure 32, allows you to select which variables to live stream and
plot during the co-simulation. Every instance in the multi-model is displayed
and the output variables are shown for each instance. Check the box for each
variable that you wish to live stream. Once the co-simulation con�guration is
complete, click the Save button at the bottom of the Con�guration box.

The Simulation box, shown in Figure 33, allows you to launch a co-simulation.
To run a co-simulation, the COE must be online. The area at the top of the
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(a) Fixed step size.

(b) Variable step size.

Figure 31: Master algorithm con�guration.

Simulation box displays the status of the COE. If the COE is o�ine, you
may click the Launch button to start it. Once a co-simulation is in progress,
any variables chosen for live streaming are plotted in real time in the simula-
tion box, as shown in Figure 34. A progress bar is also displayed. When the
simulation is complete, the live stream plot can be explored or exported as
a PNG image. In addition, an outputs.csv �le is created containing the
values of every FMU output variable at every point in time in the simula-
tion. This �le can be double-clicked and it will open with the default system
program for CSV �les. It can also be imported into programs such as R,
MATLAB or Excel for more complex analysis.
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Figure 32: Livestream con�guration.

(a) COE o�ine. (b) COE online.

Figure 33: Launching a co-simulation.
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Figure 34: Live stream variable plot.

Figure 35: Co-simulation results �le.
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4.5 Additional Features

The app has several secondary features, most of them accessible through
the Window menu, as shown in Figure 36. They are brie�y explained be-
low.

Figure 36: Additional features.

Show Settings displays a settings page where various default paths can
be set. Development mode can also be enabled from this page, but this
feature is primarily meant to be used by app developers for testing.

Show COE Server Status displays a page where you can launch and
stop the COE as well as observe its log.

Show Download Manager displays a page where installers can be down-
loaded for the various tools of the INTO-CPS tool chain, including the
COE.

Show FMU Builder displays a page that links to a service where source
code FMUs can be uploaded and cross-compiled for various platforms.
Note that this is not a secure service and users are discouraged from
uploading proprietary FMUs.

4.6 The Co-Simulation Orchestration Engine

The heart of the INTO-CPS Application is the Co-Simulation Orchestration
Engine (COE). This is the engine that orchestrates the various simulation
tools (described below), carrying out their respective roles in the overall co-
simulation. It runs as a stand-alone server hosting the co-simulation API on
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port 8080. It can be started from the app, but it may be started manually at
the command prompt for testing and specialist purposes by executing:

java -jar coe.jar 8082

TCP port 8082 will be chosen by default if it is omitted in the command
above. The COE is entirely hidden from the end user of the INTO-CPS app,
but parts of it are transparently con�gured through the main interface. The
design of the COE is documented in deliverable D4.1d [LLW+15].

The COE is controlled using simple HTTP requests. These are documented
in the API manual, which can be obtained from the COE's own web page by
navigating to http://localhost:8082. Port 8082 should be changed to
that speci�ed when the COE is started.

Following the protocol detailed in the API document, a co-simulation session
can be controlled manually from the command prompt using, for example,
the curl utility, as demonstrated in the following example.

With the COE running, a session must �rst be created:

curl http://localhost:8082/createSession

This command will return a sessionID that is used in the following com-
mands.

Next, assuming a COE con�guration �le called coeconf.json has been
created as described in the API manual, the session must be initialized:

curl -H "Content-Type: application/json"
--data @coeconf.json
http://localhost:8082/initialize/sessionID

Assuming start and end time information has been saved to a �le, say
startend.json, the co-simulation can now be started:

curl -H "Content-Type: application/json"
--data @coeconf.json
http://localhost:8082/simulate/sessionID

Once the co-simulation run ends, the results can be obtained as follows:

curl -o results.zip
http://localhost:8082/result/sessionID/zip

The session can now be terminated:

curl http://localhost:8082/destroy/sessionID
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The app fundamentally controls the COE in this way.

Distributed co-simulations Presently the app can only control the COE
in this way for non-distributed co-simulations. In order to run a distributed
co-simulation, the COE must be controlled from the command prompt manu-
ally, as illustrated above. In a distributed co-simulation the COE and (some)
FMUs execute on physically di�erent compute nodes. The FMUs local to
the COE computing node are handled in the same way as in standard co-
simulations.

Each FMU on the remote nodes is served externally by a daemon process.
This process must be started on the remote node manually as follows:

java -jar daemon.jar -host <public-ip> -ip4

Here, <public-ip> is the IPv4 address of the compute node.

Next, the COE process must be started manually from the command prompt
on its own node, with options speci�c to distributed co-simulation:

java -Dcoe.fmu.custom.factory=
org.intocps.orchestration.coe.distribution.
DistributedFmuFactory
-cp coe.jar:daemon-master.jar
org.intocps.orchestration.coe.CoeMain

The second di�erence is the way in which the location of the remote FMUs
is speci�ed. For a standard co-simulation, the “fmus” clause of the co-
simulation con�guration �le (coeconf.json, in our example) contains el-
ements of the form

“file://fmu-1-path.fmu”

These must be modi�ed for each remote FMU to the following URI scheme:

“uri://<public-ip>/FMU/#file://local-fmu-path.fmu”

The COE con�guration �le can, of course, be written manually in its entirety,
but it is possible to take a faster route, as follows.

This con�guration �le is only generated when a co-simulation is executed. It
is therefore possible to assemble a �dummy� co-simulation that is similar to
the desired distributed version, but with a local FMU topology. Since it is
likely that the remote FMUs are not supported on the COE platform itself,
it is necessary here to construct �dummy� FMUs with the same interface.
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If this local co-simulation is then executed brie�y, a COE con�guration �le
will be emitted that can be easily modi�ed as described above. The app
will name this �le config.json and emit it to the Multi-models folder
under each co-simulation run. This modi�ed con�guration can then be used
to execute the distributed co-simulation.

5 Using the Separate Modelling and Simula-

tion Tools

This section provides a tutorial introduction to the FMI-speci�c functionality
of each of the modelling and simulation tools. This functionality is centered
on the role of FMUs for each tool. For more general descriptions of each tool,
please refer to Appendix B.

5.1 Overture

Overture implements export of both tool-wrapper as well as standalone FMUs.
It also has the ability to import a modelDescription.xml �le in order to
facilitate creating an FMI-compliant model from scratch. A typical work�ow
in creating a new FMI-compliant VDM-RT model starts with the import
of a modelDescription.xml �le created using Modelio. This results in
a minimal project that can be exported as an FMU. The desired model is
then developed in this context. This section discusses the complete work-
�ow.

5.1.1 Installing the FMI import/export plugin for Overture

In order to use the FMI integration in Overture it is necessary to install a
plugin. Below is a guide to install the plugin:

1. Open Overture.

2. Select Help -> Install New Software.

3. Click Add...

4. In the Name: �eld write Overture FMU.

5. In the Location: �eld there are two options:
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INTO-CPS Application: Download theOverture FMU Import / Ex-
porter - Overture FMI Support using the Download Manager men-
tioned in Section 4.5. Locate the �le using the Archive... button
next to the Location: �eld.

Update site: Enter the following URL in the Location: �eld:
http://overture.au.dk/into-cps/vdm-tool-wrapper/master/latest.

6. Check the box next to Overture FMI Integration as shown in Figure
37.

7. Click Next or Finish to accept and install.

Figure 37: Installing Overture FMI Integration

5.1.2 Import of modelDescription.xml File

A modelDescription.xml �le is easily imported into an existing, typ-
ically blank, VDM-RT project from the project explorer context menu as
shown in Figure 38. This results in the project being populated with the
classes necessary for FMU export:

• A VDM-RT system class named �System� containing the system def-
inition. The corresponding �System� class for the water tank controller
FMU is shown in Listing 39.

• A standard VDM-RT class named �World�. This class is conventional
and only provides an entry point into the model. The corresponding
�World� class for the water tank controller FMU is shown in Listing 40.

• A standard VDM-RT class named �HardwareInterface�. This class con-
tains the de�nition of the input and output ports of the FMU. Its struc-
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Figure 38: Importing a modelDescription.xml �le.

ture is enforced, and a self-documenting annotation scheme5 is used
such that the �HardwareInterface� class may be hand-written. The
corresponding �HardwareInterface� class for the water tank controller
FMU is shown in Listing 41.

• The library �le Fmi.vdmrt which de�nes the hardware interface port
types used in �HardwareInterface�.

5The annotation scheme is documented on the INTO-CPS website into-cps.
github.io under �Constituent Model Development → Overture → FMU Import/Export.
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�
system System

instance variables

-- Hardware interface variable required by FMU Import/Export
public static hwi: HardwareInterface := new

HardwareInterface();

instance variables

public levelSensor : LevelSensor;
public valveActuator : ValveActuator;
public static controller : [Controller] := nil;

cpu1 : CPU := new CPU(<FP>, 20);
operations

public System : () ==> System
System () ==
(
levelSensor := new LevelSensor(hwi.level);
valveActuator := new ValveActuator(hwi.valveState);

controller := new Controller(levelSensor, valveActuator);

cpu1.deploy(controller,"Controller");
);

end System
� �
Figure 39: �System� class for water tank controller.
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�
class World

operations

public run : () ==> ()
run() ==
(start(System‘controller);
block();
);

private block : () ==>()
block() ==
skip;

sync

per block => false;

end World
� �
Figure 40: �World� class for water tank controller.

�
class HardwareInterface

values
-- @ interface: type = parameter, name="minlevel";
public minlevel : RealPort = new RealPort(1.0);
-- @ interface: type = parameter, name="maxlevel";
public maxlevel : RealPort = new RealPort(2.0);

instance variables
-- @ interface: type = input, name="level";
public level : RealPort := new RealPort(0.0);

instance variables
-- @ interface: type = output, name="valve";
public valveState : BoolPort := new BoolPort(false);

end HardwareInterface
� �
Figure 41: �HardwareInterface� class for water tank controller.
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The port structure used in the �HardwareInterface� class is a simple inheri-
tance structure, with a top-level generic �Port�, subclassed by ports for spe-
ci�c values: booleans, reals, integers and strings. The hierarchy is shown in
Listing 42. When a model is developed without the bene�t of an existing
modelDescription.xml �le, this library �le can be added to the project
from the project context menu, also under the category �Overture FMU�.

With all the necessary FMU sca�olding in place, the VDM-RT model can be
developed as usual.

5.1.3 Tool-Wrapper FMU Export

Models exported as tool-wrapper FMUs require the Overture tool to sim-
ulate. Export is implemented such that the VDM interpreter and its FMI
interface are included in the exported FMU. Overture tool-wrapper FMUs
currently support Win32, Win64, Linux64, Darwin64 and require Java 1.7
to be installed and available in the PATH environment variable.

A tool-wrapper FMU is easily exported from the project context menu as
shown in Figure 43. The FMU will be placed in the generated folder.
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�
class Port

types
public String = seq of char;
public FmiPortType = bool | real | int | String;

operations

public setValue : FmiPortType ==> ()
setValue(v) == is subclass responsibility;

public getValue : () ==> FmiPortType
getValue() == is subclass responsibility;

end Port

class IntPort is subclass of Port

instance variables
value: int:=0;

operations
public IntPort: int ==> IntPort
IntPort(v)==setValue(v);

public setValue : int ==> ()
setValue(v) ==value :=v;

public getValue : () ==> int
getValue() == return value;

end IntPort

class BoolPort is subclass of Port

instance variables
...
� �

Figure 42: Excerpt of �Fmi.vdmrt� library �le de�ning FMI interface port
hierarchy.
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Figure 43: Exporting a tool-wrapper FMU.
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5.1.4 Standalone FMU Export

In contrast to tool-wrapper FMUs, models exported as standalone FMUs
do not require Overture in order to simulate. Instead, they are �rst passed
through Overture's C code generator such that a standalone implementation
of the model is �rst obtained. Once compiled, this executable model then
replaces the combination of VDM interpreter and model, and the FMU ex-
ecutes natively on the co-simulation platform. Currently Mac OS, Windows
and Linux are supported, with embedded platform support for SiL and HiL
simulation under development.

The export process consists of two steps. First, a source code FMU is ob-
tained from Overture as shown in Figure 44. Second, the INTO-CPS Appli-
cation must be used to upload the resulting FMU to the FMU compilation
server using the built-in facility described in Section 4.5. This is accessed by
navigating to Window → Show FMU Builder.

Please note that only some features of VDM-RT are currently supported by
the C code generator. This is discussed in more detail in Section 8.

5.2 20-sim

This section explains the FMI and INTO-CPS related features of 20-sim6.
We focus on the import of modelDescription.xml �les, standalone and
tool-wrapper FMU export (FMU slave), 3D visualization of FMU operation
and an experimental FMU import (FMU master) feature. The complete
20-sim tool documentation can be found in the 20-sim Reference Manual
[KGD16].

5.2.1 Import of modelDescription.xml File

In Modelio it is possible to export the desired interface for a new FMU
from a multi-model as a modelDescription.xml �le (see Section 3.2.
20-sim can automatically generate an empty 20-sim submodel 7 from this
modelDescription.xml �le with this desired FMU interface. To use

6Note that 20-sim is Windows-only. However, it can run �ne using Wine [Win16] on
other platforms. For details on using 20-sim under Wine, contact Controllab.

7Please note that the term �submodel� here should not be confused with the INTO-CPS
notion of a �constituent model�. A submodel here is a part in a graphical 20-sim model.
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Figure 44: Exporting a standalone FMU.

the modelDescription.xml import, you will need to use the �4.6.2-
intocps� version of 20-sim8, since this feature is still under development. A
modelDescription.xml �le can be imported into 20-sim by using Win-
dows Explorer to drag the modelDescription.xml �le onto your 20-sim
model (see Figure 45). This creates a new empty submodel with a blue icon
that has the same inputs and outputs as de�ned in the modelDescription
.xml �le.

5.2.2 Tool-wrapper FMU Export

A tool-wrapper FMU is a communication FMU that opens the original model
in the modelling tool and takes care of remotely executing the co-simulation

8You can download the INTO-CPS version of 20-sim using the Download Manager in
the INTO-CPS Application.
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Figure 45: Import a ModelDescription in 20-sim.

steps inside the modelling using some tool-supported communication mecha-
nism. 20-sim supports co-simulation using the XML-RPC-based DESTECS
co-simulation interface [LRVG11]. The generation of a tool-wrapper FMU
involves two steps that will be explained below:

1. Extend the model with co-simulation inputs, outputs and shared design
parameters.

2. Generate a model-speci�c tool-wrapper FMU.

The tool-wrapper approach involves communication between the co-simula-
tion engine (COE) and the 20-sim model through the tool-wrapper FMU.
The 20-sim model should be extended with certain variables that can be
set or read by the COE. These variables are the co-simulation inputs and
outputs. They can be de�ned in the model in an equation section called
externals:�

externals
real global export mycosimOutput;
real global import mycosimInput;
� �

To make it possible to set or read a parameter by the co-simulation engine,
it should be marked as ’shared’:�

parameters
// shared design parameters
real mycosimParameter (’shared’) = 1.0;
� �

The next step is to generate a tool-wrapper FMU for the prepared model.
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This requires at least the �4.6.3-intocps� version of 20-sim9. This version of
20-sim comes with a Python script that generates a tool-wrapper FMU for
the loaded model.

To generate the tool-wrapper FMU:

1. Make sure that the tool-wrapper prepared 20-sim model is saved at
a writable location. The tool-wrapper FMU will be generated in the
same folder as the model.

2. Open the prepared 20-sim model in 20-sim.

3. Run the BATCH script:
C:\Program Files (x86)\20-sim 4.6\addons\FMI\
ToolwrapperFMUExport\generate.bat
Note that the (x86) is only for 64-bit versions of Windows.

4. You can �nd the generated tool-wrapper fmu as <modelname>.fmu in
the same folder as your model.

5.2.3 Standalone FMU Export

Starting with 20-sim version 4.6, the tool has a built-in option to generate
standalone co-simulation FMUs for both FMI 1.0 and 2.0 (note that version
2.0 must be used here).

To export a 20-sim submodel as a standalone FMU, make sure that the part
of the model that you want to export as an FMU is contained in a submodel
and simulate your model to con�rm that it behaves as desired.

Next, follow these steps (see also Figure 46):

1. In the Simulator window, choose from the menu: Tools.

2. Select Real Time Toolbox.

3. Click C-Code Generation.

4. Select the FMU 2.0 export for 20-sim submodel target.

5. Select the submodel to export as an FMU.

6. Click OK to generate the FMU. This will pop-up a blue window.

9You can download the INTO-CPS version of 20-sim using the Download Manager in
the INTO-CPS Application.
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Figure 46: Export an FMU from 20-sim.

Note that to automatically compile the FMU, you will need the Microsoft
Visual C++ 2010, 2013 or 2015 compiler installed (normally included with
Microsoft Visual Studio, either Express or Community edition). If 20-sim
can �nd one of the supported VC++ compilers, it starts the compilation
and reports where you can �nd the newly generated FMU. The 20-sim FMU
export also generates a Make�le that allows you to compile the FMU on
Windows using Cygwin, MinGW, MinGW64 or on Linux or MacOS X.
20-sim can currently export only a subset of the supported modelling lan-
guage elements as standalone C-code. Full support for all 20-sim features is
only possible through the tool-wrapper FMU approach (described shortly in
Section 5.2.2). The original goal for the 20-sim code generator was to export
control systems into ANSI-C code to run the control system under a real-
time operating system. As a consequence, 20-sim currently only allows code
generation for discrete-time submodels or continuous-time submodels using
a �xed-step integration method. Support for variable step size integration
methods is not yet included by default in the o�cial 20-sim 4.6 release, but it
is already included in the 20-sim �4.6.2-intocps� release and on GitHub (see
below). Other language features that are not supported, (or are only partly
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supported) for code generation, are:

• Hybrid models: Models that contain both discrete- and continuous-
time sections cannot be generated at once. However, it is possible to
export the continuous and discrete blocks separate.

• File I/O: The 20-sim �Table2D� block is supported; the �datafrom�le�
block is not yet supported.

• External code: Calls to external code are not supported. Examples
are: DLL(), DLLDynamic() and the MATLAB functions.

• Variable delays: The tdelay() function is not supported due to
the requirement for dynamic memory allocation.

• Event functions: timeevent(), frequencyevent() statements
are ignored in the generated code.

• Fixed-step integration methods: Euler, Runge-Kutta 2 and Runge-
Kutta 4 are supported.

• Implicit models: Models that contain unsolved algebraic loops are
not supported.

• Variable-step integration methods: Vode-Adams andModi�ed Back-
ward Di�erential Formula (MeBDF) are available on GitHub (see below
for the link).

The FMU export feature of 20-sim is being improved continuously based on
feedback from INTO-CPS members and other customers. To bene�t from
bug �xes and to try the latest FMU export features like variable step size
integration methods (e.g. Vode-Adams and MeBDF), you can download the
latest version of the 20-sim FMU export template from:

https://github.com/controllab/fmi-export-20sim

Detailed instructions for the installation of the GitHub version of the 20-sim
FMU export template can be found on this GitHub page. The GitHub FMU
export template can be installed alongside the existing built-in FMU export
template.

5.2.4 3D Animation FMU

It is possible to visualize a 20-sim simulation as a live 3D animation. This 20-
sim 3D animation can be exported as a 3D animation FMU that can be used
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for visualization purposes in a FMI co-simulation experiment. An example
of a 3D animation FMU in action is shown in Figure 47.

Figure 47: 3D animation FMU

To create a 3D animation FMU, you will need to create a 3D animation in
20-sim that reacts to some signals �rst (identical to the creation of standard
3D animation in 20-sim):

1. Open your 20-sim model.

2. Open the simulator and add a new 3D animation window using View
→ New 3D animation window.

3. Create a new 3D animation scene by following the instructions from
the Animation toolbox section in the 20-sim Getting Started manual
[KG16].

4. For elements that should move or change color based on external sig-
nals, create one equation submodel in 20-sim with all required input
signals for the animation.

5. Connect the 3D animation object to the signals from this animation
submodel.

The next step is to export the 3D animation as standalone scenery:

1. Go to the 3D animation plot in your 20-sim model.
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2. Right-click in the 3D animation plot and select Plot properties.

3. Choose File → Save scene.

4. Select Yes to save the whole scenery.

5. Save the scenery under the name scenery.scn.

The 3D animation FMU uses the just exported scenery.scn �le. Since
the 3D animation is only a view of the simulation results, the FMU only has
a list of inputs. To generate a modelDescription.xml �le with the right
FMU interface, a Python script must be executed which collects the list of
external signals referred to by the exported scenery. This Python script and
other required resources can be found in the following Controllab GitHub
repository:

https://github.com/controllab/fmi-3D-animation

To generate the FMU modelDescription.xml �le, do the following:

1. Copy the generated scenery.scn in the fmu_sources\resources
folder under 3D FMU instructions.

2. Update FMU_GUID in the scenery_to_fmu.py Python script with
a new GUID for your 3D Animation FMU.

3. Execute the scenery_to_fmu.py Python script, e.g. using the Python
installation that comes with 20-sim 4.6:

• Start IPython found under 20-sim 4.6 in theWindows Start Menu.

• cd <my 3D FMU instructions path>

• run scenery_to_fmu.py
This parses the scenery.scn �le for objects that point to vari-
ables/parameters (references). The variables/parameters are trans-
lated to FMU inputs and FMU parameters. The 3D scenery does
not contain any information that indicates whether the referred
name is a variable or a parameter. As a workaround, all names
that start with parameter. are marked as as FMU parameters
(causality = parameter), while all others are generated as inputs
(variability = continuous). This script also generates a scenery.
txt �le with the list of found references. This �le is read by the
3D animation DLL to couple the FMU interface to the 3D scenery
objects. The output resembles that shown in Figure 48.

4. Create the actual FMU:

51

https://github.com/controllab/fmi-3D-animation


D4.3a - INTO-CPS Tool Chain User Manual (Public)

• Copy all needed textures to the fmu_sources\resources folder.

• Zip the fmu_sources folder.

• Rename the Zip �le, e.g. 3DAnimationFMU.fmu.

Figure 48: Generating modelDescription.txt �le from 3D scenery.

5.2.5 FMI 2.0 Import

The �4.6.2-intocps� version of 20-sim has an experimental option to import
an FMU directly in 20-sim for co-simulation within 20-sim itself. This is
useful for quickly testing exported FMUs without the need to set-up a full
co-simulation experiment in the app. Presently only FMI 2.0 co-simulation
FMUs can be imported.

The procedure for importing an FMU as 20-sim submodel is similar to im-
porting a modelDescription.xml �le. Follow these steps to import an
FMU in 20-sim:

1. Copy/move the FMU to the same folder as your model. This is not
required but recommended to prevent embedding hardcoded paths in
your model.

2. Using Windows Explorer, drag the FMU �le on your 20-sim model (see
Figure 49).
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Figure 49: Importing an FMU in 20-sim.

This creates a new submodel with a blue icon that acts as an FMU wrap-
per. FMU inputs and outputs are translated into 20-sim submodel input
and output signals. FMU parameters (scalar variables with causality �pa-
rameter�) are also available in 20-sim. This means that you can alter the
default values of these FMU parameters in 20-sim. The altered FMU param-
eters are transferred to the FMU during the initialization mode phase of the
FMU.

5.3 OpenModelica

This section explains the FMI and INTO-CPS related features of Open-
Modelica. The focus is on import of modelDescription.xml �les, and
standalone and tool-wrapper FMU export.

5.3.1 Import of modelDescription.xml File

OpenModelica can import modelDescription.xml interface �les cre-
ated using Modelio and create Modelica models from them. To use the
modelDescription.xml import feature, you will need to use OpenMod-
elica nightly-builds versions, as this extension is rather new. Nightly builds
can be obtained through the main INTO-CPS GitHub site:

http://into-cps.github.io

To import a modelDescription.xml �le in OpenModelica one can use:
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1. The OpenModelica Connection Editor GUI (OMEdit): FMI → Import
FMI Model Description.

2. A MOS script, i.e. script.mos, see below.�
// start script.mos
// import the FMU modelDescription.xml
importFMUModeldescription("path/to/modelDescription.xml");

getErrorString();
// end script.mos
� �

The MOS script can be executed from command line via:�
// on Linux and Mac OS
> path/to/omc script.mos
// on Windows
> %OPENMODELICAHOME%\bin\omc script.mos
� �

The result is a generated �le with a Modelica model containing the inputs
and outputs speci�ed in modelDescription.xml. For instance:�

model Modelica_Blocks_Math_Gain_cs_FMU "Output the product
of a gain value with the input signal"

Modelica.Blocks.Interfaces.RealInput u "Input signal
connector" annotation(Placement(transformation(extent
={{-120,60},{-100,80}})));

Modelica.Blocks.Interfaces.RealOutput y "Output signal
connector" annotation(Placement(transformation(extent
={{100,60},{120,80}})));

end Modelica_Blocks_Math_Gain_cs_FMU;"
� �
This functionality will ultimately be integrated in the OMEdit (the Open-
Modelica Connection Editor) graphical user interface.

5.3.2 FMU Export

Currently all FMUs exported from OpenModelica are standalone. There are
two ways to export an FMU:

1. From a command prompt.

2. From OMEdit (OpenModelica Connection Editor).
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FMU export from a command prompt To export an FMU for co-
simulation from a Modelica model a Modelica script �le generateFMU.mos
containing the following calls to the OMC compiler can be used:�

// load Modelica library
loadModel(Modelica); getErrorString();

// load other libraries if needed
// loadModel(OtherLibrary); getErrorString();

// generate the FMU: PathTo.MyModel.fmu
translateModelFMU(PathTo.MyModel, "2.0", "cs");

getErrorString();
� �
Next, the OMC compiler must be invoked on the generateFMU.mos script:�

// on Linux and Mac OS
> path/to/omc generateFMU.mos
// on Windows
> %OPENMODELICAHOME%\bin\omc generateFMU.mos
� �

FMU export from OMEdit One can also use OMEdit (the OpenMod-
elica Connection Editor) to export an FMU as detailed in the �gures be-
low.

• Open OMEdit (see Figure 50).

• Load the model in OMEdit (see Figure 51).

• Open the model in OMEdit (see Figure 52).

• Use the menu to export the FMU (see Figure 53).

• The FMU is now generated (see Figure 54).

The generated FMU will be saved to %TEMP%\OpenModelica\OMEdit.
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Figure 50: Opening OMEdit.

Figure 51: Loading the Modelica model in OMEdit.
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Figure 52: Opening the Modelica model in OMEdit.

Figure 53: Exporting the FMU.

57



D4.3a - INTO-CPS Tool Chain User Manual (Public)

Figure 54: Final step of FMU export.
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6 Design Space Exploration for INTO-CPS

This section provides a description of tool support for design space explo-
ration (DSE) developed as part of the INTO-CPS project. Presently the
INTO-CPS Application does not provide support for automated creation of
the con�guration �les required to de�ne a DSE experiment. Therefore, this
section is split into three parts. Section 6.1 describes how the INTO-CPS
Application can be used to launch a DSE using an existing con�guration
�le and Section 6.2 describes how the results from DSE are generated and
stored. Section 6.3 describes the structure of the DSE con�guration �le, giv-
ing enough detail for the user to be able to edit one for their purposes.

6.1 How to Launch a DSE

To launch a DSE we need to provide the INTO-CPS Application with the
path to two �les. The �rst is the DSE con�guration, de�ning the parameters
of the design space, how it should be searched, measured and the results com-
pared. The second is the multi-model con�guration, de�ning the base model
that will be used for the search. A DSE con�guration is selected by double
clicking on one of the con�gurations listed in the Design Space Explorations
section of the INTO-CPS Application project explorer; these con�gurations
are identi�ed with the ( ) icon. If the COE is not already running, the
DSE page is shown with a red �Co-simulation engine not running� status,
as shown in Figure 55.

If this is the case, click on the Launch button to start the COE. This re-
sults in a green co-simulation engine status (see Figure 56). With the DSE
con�guration selected and the COE running, the next step is to select the
multi-model to use. One can be selected from the Co-simulation Con�gura-
tion drop-down box, as shown in Figure 57. Pressing the Simulate button
starts the DSE background process.
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Figure 55: Status when COE is not running.

Figure 56: Status when COE is running.

Figure 57: Selecting a multi-model.
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6.2 Results of a DSE

The DSE scripts store their results in a folder named for the date and time
at which the DSE was started. This folder may be found underneath the
name of the DSE script selected, as shown in Figure 58. When the DSE has
�nished, we can �nd both a graphs folder and an HTML results page inside
the results folder. It may be necessary to refresh the project view to see these
new items. The results HTML �le is identi�ed by the ( ) icon, and double
clicking on it opens the results page in the default browser.

Figure 58: Icon shown when DSE results are ready.

The results, shown in Figure 59, contain two elements. The �rst element is
a Pareto graph showing the results of all simulations on a single plot, with
each point on the graph representing a single simulation. The best designs,
referred to as the non-dominated set, are shown in blue, with ranks of progres-
sively worse designs coloured alternately red and yellow. The second element
is a table of these results, with the rank in the left hand column, followed
by the objective values and �nally the design parameters that produced the
result.

6.3 How to Edit a DSE Con�guration

Editing of a DSE con�guration is currently a manual process and so guidance
regarding each section of the con�guration is presented in this section.
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Figure 59: A page of DSE results.

6.3.1 File Creation

The suggested procedure for creating a new con�guration is to make a copy
of an existing one and then to edit the required sections. The individual
con�gurations are located in their own folders within the Design Space
Exploration folder of the INTO-CPS Application project directory, such
as the pilot study with the line following robot �LFR-2SensorPositions� con-
�guration shown in Figure 60 (see [PGP+16]). Using your OS's �le browser,
create a new folder under DSEs and then copy in and rename a DSE con�gu-
ration. The names of the new folder and con�guration folder can be chosen at
will, but the con�guration �le must have the extension .dse.json .
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Figure 60: Location of DSE con�gurations.

6.3.2 Parameters

The parameters section is used to de�ne a list of values for each parameter
to be explored. Figure 61 shows the de�nition of four parameters, each with
two values. If a parameter is included in the DSE con�guration �le, then it
must have at least one value de�ned. The order of the values in the list is
not important. If a parameter that is to be explored is not in the list, its ID
may be found in the three ways listed below.

1. If the parameter is listed in the multi-model con�guration, then copy
it from there.

2. If the parameter is not in the multi-model parameters list then its name
may be found by examining the model description �le in the associated
FMU. In this case it will be necessary to prepend the parameter ID
with the ID for the FMU and the instance ID of the FMU, for example
in �{sensor1FMU}.sensor1.lf_position_x�.

• the ID of the FMU is {sensor1FMU}.

• the instance ID of the FMU in the multi-model is sensor1.

• the parameter ID is lf_position_x.

3. The IDs for each parameter may also be found on the Architecture
Structure Diagram in the SysML models of the system. The full name
for use in the multi-model may then be constructed as above.
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Figure 61: Example parameter de�nitions.

6.3.3 Parameter Constraints

It may be the case that not all combinations of the parameter values de�ned
in the previous section are valid. So, it is necessary to be able to de�ne
constraints over the design parameters such that no time is wasted simulating
invalid designs. For example, in the line follower robot we de�ne ranges for
the x and y co-ordinates of the left and right sensors separately, and running
all combinations of these leads to asymmetric designs that do not have the
same turning behaviour on left and right turns. To prevent this we can de�ne
boolean expressions based upon the design parameters and evaluate these
before a simulation is launched. Figure 62 shows two constraints de�ned for
the line follower DSE experiment that ensure only symmetrical designs are
allowed. The �rst constraint ensures the y co-ordinates of both sensors are
the same, while the second constraint ensures that the x co-ordinate of the
left sensor is the same, but negated as the x co-ordinate of the right sensor.
Note that the names used when de�ning such constraints have the same
FMU_ID.instance_ID.parameter_ID format as used when de�ning a
parameter range (see Section 6.3.2)

Since the constraints are processed using the Python eval function, any
boolean expression compatible with it may be used here.

Figure 62: Example parameter constraints.

64



D4.3a - INTO-CPS Tool Chain User Manual (Public)

6.3.4 Scenario List

The DSE scripts currently have limited support for scenarios referring to a
speci�c set of conditions against which the multi-model is to be tested. In
the example of the line following robot, the scenario refers to the map the
robot has to follow, along with its starting co-ordinates. For instance, in
one scenario the robot would go around a circular track in one direction,
predominantly turning left, whereas in a di�erent scenario the same track
would be followed in the opposite direction, predominantly turning right. In
both scenarios the map of the track is the same.

Changing a scenario may involve changing one or more di�erent parts of
the multi-model and its analysis, such as the speci�c FMUs used, parame-
ters passed to an FMU, the multi-model the DSE is based upon, along with
any data �les used by the objective scripts (Section 6.3.6) to evaluate perfor-
mance. This feature is currently under development and so only the objective
data �le selection is implemented presently.

6.3.5 Objective De�nitions: Internal

There are two means for de�ning the objectives used to assess the perfor-
mance of a simulated model. The �rst of these, described here, is using the
internal functions included in the DSE scripts. This is a set of simple func-
tions that can be applied to any of the values recorded by the COE during
simulation. The current set of internal functions is:

max Returns the maximum value of a variable during a simulation.

min Returns the minimum value of a variable during a simulation.

mean Returns the mean value of a variable during a simulation (n.b., a �xed
simulation step size is currently assumed.)

De�ning an internal objective requires three pieces of information:

name This is the name that the objective value will be stored under in the
objectives �le.

type This selects the function to be applied. The key objectiveType is
used in the DSE con�guration �le.

variable This de�nes the variable to which the function is to be applied.
The key columnID is used to denote this parameter in the DSE con-
�guration �le.
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Figure 63: De�nition of an internal objective.

Figure 63 shows the de�nition of an objective named energyConsumed,
which records the maximum value of the variable
{bodyFMU}.body.total_energy_used. This objective is recorded and
may be used later, primarily for the purpose of ranking designs, but it could
also be used for any other analysis required.

6.3.6 Objective De�nitions: External Scripts

The second form of objective de�nition makes use of user-de�ned Python
scripts to allow bespoke analysis of simulation results to be launched auto-
matically and results recorded using the common format. The de�nition has
two parts: the construction of the Python script to perform the analysis and
the de�nition of the script's required parameters in the DSE con�guration
�le, these two steps are described below.

Construction of the Script The outline functionality of an analysis script
is that, at the appropriate times, a DSE script calls it, passing four or more
arguments. The script uses these arguments to locate a raw simulation results
�le (results.csv), processes those results and then writes the objective
values into an objectives �le (objectives.json) for that simulation.

The �rst three arguments sent to the script are common to all scripts. These
are listed below.

argv 1 The absolute path to the folder containing the results.csv re-
sults �le. This is also the path where the script �nds the
objectives.json �le.

argv 2 The name of the objective. This is the key against which the script
should save its results in the objectives �le.

argv 3 The name of the scenario.

With this information the script can �nd the raw simulation data and also
determine where to save its results. The name of the scenario allows the script
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to locate any data �les it needs relating to the scenario. For example, in the
case of the script measuring cross track error for the line following robot,
the script makes use of a data �le that contains a series of coordinates that
represent the line to be followed. The name of this data �le is map1px.csv.
It is placed into a folder with the same name as the scenario, which in this
case is studentMap. That folder is located in the userMetricScripts
folder, as shown in Figure 64. Using this method, the developer of an external
analysis script needs only to de�ne the name of the data �le they will need and
know that at runtime the script will be passed a path to a folder containing
the data �le suitable for the scenario under test.

Figure 64: External analysis script data �les for the �studentMap� scenario.

Figure 65 shows an example of an external analysis script. In this case it
computes the cumulative deviation of the water level from some target level.
There are two distinct sections in the �le, we shall refer to them as the
'common' and 'script speci�c' sections.

The common section contains core functions that are common to all ex-
ternal scripts. It reads in the three arguments that are common to all
scripts, and contains functions to help the user retrieve the data needed
by the analysis script, and to write the computed objective value into the
objectives.json �le. It is recommended that this section be copied to
form the basis of any new external analysis scripts.

The second part of the example script shown is speci�c to the analysis to
be performed. The purpose of this section is to actually compute the value
of the objective from the results of a simulation. Generally it will have
three parts: reading in any analysis speci�c arguments such as the ID of
data in the results that it needs, using the data in results.csv to cal-
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Figure 65: External analysis script to calculate cumulative deviation in the
water tank example
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culate the value of the objective and �nally write the objective value into
objectives.json.

In the 'Script Speci�c Section' of Figure 65 we see the example of the script
calculating the cumulative deviation of the water level from a target level in
the water tank model. It starts by reading a further two arguments passed
when the script is launched and initializes the variables. The script then it-
erates through all rows of data in results.csv to calculate the cumulative
deviation which is then written to the objectives.json �le in the �nal
line.

Figure 66: De�nition of the external analysis functions for the line follower
robot.

De�nition of External Analysis in DSE Con�guration With the
analysis scripts constructed, the next step is to de�ne their use in the DSE
con�guration �le. The de�nition essentially contains three parts:, a name for
the objective, the �le name of the script and a list arguments to pass. The
name given to the objective allows it to be referenced in the objectives con-
straints and ranking sections of the DSE con�guration. The �le name tells
the DSE scripts which script to launch and the arguments de�ne additional
data (over the standard three arguments described earlier) that the script
needs, such as the names of data it needs or constant values.

In Figure 67 we �nd the de�nition of the external analysis used in the three
tank water tank example. There are two analysis de�ned, the �rst is named
'cumulativeDeviation' and the second is 'vCount'. In each there are two
parameters de�ned, the 'scriptFile' contains the �le name of the script �le to
run in each case, while the 'scriptParameters' parameter contains the list of
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additional arguments each needs.

Figure 67: De�nition of the external analysis functions for the three water
tank model.

The purpose of both internal and external analysis functions is to populate
the objectives.json �le with values that characterize the performance
of the designs being explored. Figure 68 shows an example objectives �le
generated during a DSE of the three water tank example. There is an instance
of the objectives �le created for each simulation in DSE, its primary use being
to inform the ranking of designs, but it may be used for any other analysis a
user wishes to de�ne.

Figure 68: Contents of objectives.json �le for a single simulation of
the three tank water tank

6.3.7 Ranking

The �nal part of a DSE con�guration �le concerns the placing of designs in a
partial order according to their performance. The DSE currently supports a
Pareto method of ranking, as was shown earlier in Figure 59. The purpose of
the ranking section of the con�guration is to de�ne the pair of objectives that
will be used to rank the designs, and whether to maximize or minimize each.
Figure 69 shows an example of a ranking de�nition from the line following
robot example. Here the user has speci�ed that the lap time and mean
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cross track error objectives will be used to rank. The use of '-' after each
indicates that the aim is to minimize both, whereas a '+' indicates the desire
to maximize.

Figure 69: De�ning parameters and their preferred directions for ranking.

Combining all these sections results in a complete DSE con�guration, as
shown in Figure 70.
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Figure 70: A complete DSE con�guration for the line follower robot example.
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7 Test Automation and Model Checking

Test Automation and Model Checking for INTO-CPS is provided by the RT-
Tester RTT-MBT tool. This section �rst describes installation and con�gu-
ration of RT-Tester MBT in Section 7.1. It then describes test automation
in Section 7.2 and model checking in Section 7.3. Note, that these features
are explained in more detail in the deliverables D5.2a [PLM16] and D5.2b
[BLM16], respectively.

7.1 Installation of RT-Tester RTT-MBT

In order to use RTT-MBT, a number of software packages must be installed.
These software packages have been bundled into two installers:

• VSI tools dependencies bundle:
This bundle is required on the Windows platform and installs the fol-
lowing third party software:

� Python 2.7.

� GCC 4.9 compiler suite, used to compile FMUs.

• VSI tools � VSI Test Tool Chain:

� RT-Tester 6.0, a stripped version of the RT-Tester core test system
that contains the necessary functionality for INTO-CPS.

� RT-Tester MBT 9.0, the model-based testing extension of RT-
Tester.

� RTTUI 3.9, the RT-Tester graphical user interface.

� Utility scripts to run RTT-MBT.

� Examples for trying out RTT-MBT.

These bundles can be downloaded via the download manager of the INTO-
CPS Application.

7.1.1 Setup of the RT-Tester User Interface

When the RT-Tester User Interface (RTTUI) is �rst started, a few con�gu-
ration settings must be made.
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• User name and company name (Figure 71a).

• Location of Bash shell (Figure 71b): You can safely skip this step by
clicking Next.

• Path to Python 2.7 executable (Figure 71c): Click Detect and then
Installation Path for auto-detection, or Browse to select manually.

• Location of RT-Tester (Figure 71d): Click Browse to select the direc-
tory of your RT-Tester installation. Note that if you did not specify
the Bash shell location in step 7.1.1, the version number might not be
properly detected.

(a) Con�guring user.
(b) Con�guring Bash.

(c) Con�guring Python. (d) Con�guring RT-Tester.

Figure 71: RT-Tester GUI con�guration.

7.2 Test Automation

Con�guring and using a Test Project involves several activities. These are:

• Creating a test project.

• De�ning tests.
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• Compiling test driver FMUs.

• Setting up test runs.

• Running tests.

• Evaluating test results.

These activities can be performed either solely using the RT-Tester graphical
user interface, or using a combination of the INTO-CPS Application and the
RT-Tester GUI. In this section we focus on describing the latter, since it
supports the complete set of features necessary for test automation. The
INTO-CPS Application currently only exposes a subset of these. A more
comprehensive description of the test automation work�ow can be found in
deliverable D5.2a [PLM16].

In the INTO-CPS Application test automation functionality can be found
below the main activity Test-Data-Generation in the project browser. Before
using most of the test automation utilities, the license management process
has to be started. To this, end right-click on Test-Data-Generation and select
Start RT-Tester License Dongle (see Figure 72).

Figure 72: Starting the license management process.

After developing the behavioural model in Modelio and exporting it to an
XMI �le, test automation projects can be created from the INTO-CPS Ap-
plication. Such a project is then added as a sub-project within a containing
INTO-CPS Application project. To create a project, do the following:

75



D4.3a - INTO-CPS Tool Chain User Manual (Public)

1. Right-click on Test-Data-Generation in the project browser and select
Create Test Data Generation Project (see Figure 73).

2. Specify a name for the project, select the XMI �le containing the test
model and press Create, as shown in Figure 74.

Figure 73: Creating a test automation project.

The newly created sub-project and its directory hierarchy is displayed in the
project browser. Some directories and �les of the RT-Tester project that
are not of great importance to the INTO-CPS work�ow are hidden from the
browser. The following two folders are of special signi�cance:

• TestProcedures contains symbolic test procedures where test objec-
tives are speci�ed in an abstract way, for example by specifying Linear
Temporal Logic (LTL) formulas.

• From these symbolic test procedures, concrete executable (RT-Tester 6)
test procedures are generated, which then reside in the folder RTT_
TestProcedures.

The speci�cation of test objectives is done using the RT-Tester GUI. The
relevant �les can be opened in the RT-Tester GUI directly from the INTO-
CPS Application by double-clicking them:

• conf/generation.mbtconf allows you to specify the overall test
objectives of the test procedure. Test objectives can be speci�ed as
LTL formulas, which must then be ful�lled during a test run. Test
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Figure 74: Test automation project speci�cs.

goals can also be speci�ed by selecting structural elements from a tree
representation of the test model and then choosing a coverage metric
for that element. For example, the user might select a sub-component
of the System Under Test (SUT) and specify that all Basic Control
States (BCS) must be reached (see Figure 75), or that all transitions
must be exercised (TR) in a test run.

• conf/signalmap.csv allows you to con�gure the input and output
signals of the system under test (see Figure 76). This includes de�ning
the admissible signal latencies for checking the SUT's outputs in a test
run. This �le also allows you to restrict the range of the signals in order
to constrain these values during test data generation.

More details on the de�nition of tests can be found in deliverable D5.2a
[PLM16].

After de�ning the test objectives, a concrete test case can be created by right-
clicking on the symbolic test case under TestProcedures and then selecting
Solve (see Figure 77).
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Figure 75: Con�guring a test goal.

Figure 76: Con�guring signals.
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Figure 77: Generating a concrete test procedure.
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A solver component then computes the necessary timed inputs to realize the
test objectives. A concrete test procedure is generated that feeds a system
under test with these inputs and observes its outputs against expected results
derived from the test model. This test procedure will be placed in RTT_
TestProcedures and has the same name as the symbolic test procedure.
Figure 78 shows how test generation progresses.

Figure 78: Test data generation progress.

A generated test procedure can be cast into an FMU, which can then be
run in a co-simulation against the system under test. To this end, right
click on the concrete test procedure and select Generate Test FMU (see
Figure 79). In cases where a real and perhaps physical system under test is
not available, a simulation of the system under test can be generated from
the behavioural model. To generate such an FMU, right-click on Simulation
an select Generate Simulation FMU as depicted in Figure 80.

In order to run a test, right-click on the test procedure and select Run Test
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Figure 79: Generating a test FMU.

Figure 80: Generating a simulation FMU.

(see Figure 81). Then specify the FMU of the system under test. If the sys-
tem under test is to be replaced by a simulation, press on the corresponding
Simulation button. The duration of the test is derived during test data gen-
eration and does not need to be manually speci�ed. However, an appropriate
step size must be set. Finally, after making sure the COE is running, press
Run to start the test (see Figure 82).

Every test execution yields as its result an evaluation of test cases, i.e., each is
associated with a verdict of PASS, FAIL, or INCONCLUSIVE.10 The details
are found in the test log �les below the folder testdata. See the RT-Tester

10The verdict can also be NOT TESTED. This means a test case has been included in
a test procedure, but a run that reaches it is still missing.
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Figure 81: Running a test.

user manual [Ver15a] for details.

The �le testcase_tags.txt gives a condensed record of test case, ver-
dict, and point in a *.log �le where a corresponding PASS, FAIL, or�
in case of INCONCLUSIVE�test case occurrence without assertion can
be found. The project-wide test-case verdict summary as well the require-
ment verdict summary can be found in the folder RTT_TestProcedures/
verification. More details on the evaluation of test runs can be found
in deliverable D5.2a [PLM16].

7.3 Model Checking

This section describes how to use the INTO-CPS Application as a front-
end to the LTL model checker of RT-Tester RTT-MBT. More details on the
algorithms used and the syntax of LTL formulas can be found in deliverable
D5.2b [BLM16].

Once an INTO-CPS project has been created (see Section 4.2), model check-
ing functionality can be found under the top-level activity Model Checking in
the project browser. Before getting started, the RT-Tester license manage-
ment process must be launched. To this end, right-click on Model Checking
and select Start RT-Tester License Dongle (see Figure 83). Model checking
projects are presented as sub-projects of INTO-CPS Application projects. In
order to add a new project,

1. Right-click on the top-level activity Model Checking in the project
browser and select Create Model Checking Project (see Figure 84).
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Figure 82: Con�guring a test.

2. Provide a project name and the model that has been exported to XMI
from Modelio.
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Figure 83: Starting the RT-Tester license dongle.

Figure 84: Creating a model checking project.
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Figure 85: Specifying the model checking project.
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After pressing Create, a new node representing the model checking project is
added to the project browser.

The next step is to add LTL queries to the project:

1. Right click on the project and select Add LTL Query (see Figure 86).

2. Enter a name for the new query (see Figure 87).

3. To edit the LTL query, double click on the corresponding node in the
project browser (see Figure 88). The LTL formula can then be edited in
a text �eld. Note that the editor supports auto-completion for variable
names and LTL operators (see Figure 89).

4. Provide the upper bound for the bounded model checking query.

Figure 86: Adding an LTL formula.

Figure 87: Naming the new LTL formula.
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Figure 88: Opening the LTL formula editor.

To check the query, press Save & Check. A window opens and is �lled with
the output of the model checking tool. The tool either reports that the query
holds within the speci�ed number of steps � as depicted in Figure 90 � or
it prints a counterexample to demonstrate that the property does not hold.

It is possible to con�gure abstractions11 for a particular model checking
project. To do so, double-click on the corresponding Abstractions node below
that project in the project browser. It is then possible to choose an abstrac-
tion method for each output variable of an environment component along
with making the associated setting. In Figure 91 the interval abstraction has
been selected for the output variable voltage. This abstraction has further
been con�gured to restrict the variable's value within the interval [10, 12].
After pressing Save, this abstraction is applied to all model checking queries
in the current model checking project.

11Information on abstractions and their associated con�guration items can be found in
deliverable D5.2b [BLM16].
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Figure 89: LTL formula editor.

Figure 90: Model checking result.
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Figure 91: Con�guring abstractions.
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8 Code Generation for INTO-CPS

Of all the INTO-CPS tools, Overture, OpenModelica and 20-sim have the
ability, to varying degrees, to translate models into platform-independent C
source code. Overture can moreover translate VDM models written in the
executable subset of VDM++ [LLB11] (itself a subset of VDM-RT) to Java,
but C is the language of interest for the INTO-CPS technology.

The purpose of translating models into source code is twofold. First, the
source code can be compiled and wrapped as standalone FMUs for co-
simulation, such that the source tool is not required. Second, with the aid of
existing C compilers, the automatically generated source code can be com-
piled for speci�c hardware targets.

The INTO-CPS approach is to use 20-sim 4C to compile and deploy the code
to hardware targets, since the tool incorporates the requisite knowledge re-
garding compilers, target con�guration etc. This is usually done for control
software modelled in one of the high-level modelling notations, after valida-
tion through the INTO-CPS tool chain. Deployment to target hardware is
also used for SiL and HiL validation and prototyping.

For each of the modelling and simulation tools of the INTO-CPS tool chain,
code generation is a standalone activity. As such, the reader should refer to
the tool-speci�c documentation referenced in Appendix B for guidance on
code generation. Deliverable D5.1d [HLG+15] contains the details of how
each tool approaches code generation.

The remainder of this section lists information about the code generation
capabilities of each tool. It describes what the user can expect currently
from each tool's code generator, in the hopes that this will be helpful in
eliminating stumbling blocks for new users trying to quickly get started with
the INTO-CPS tool chain. Extensive guidance on how to tailor models for
problem-free translation to code can be found in the tools' individual user
manuals, as referenced in Appendix B.

8.1 Overture

A complete description of Overture's C code generator can be found in the
Overture User Manual, accessible through Overture's Help system. As a
quick-start guide, this section only provides an introduction to invoking the
C code generator, and an overview of the features of VDM-RT that are
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currently considered stable from a code generation point of view.

The C code generator is invoked from the context menu in the Project Ex-
plorer as shown in Figure 92. The code generator currently supports the

Figure 92: Invoking the code generator.

following VDM-RT language constructs:

• Basic data types and operations: integers, reals, booleans, etc.

• The is_ type test for basic types.

• Quote types.

• let expressions.

• Pattern matching.

• For loops.

• case expressions.

• Record types.

• Aggregate types and operations: sets, sequences, maps (to a limited
extent).

• Object-oriented features: classes and class �eld access, inheritance,
method overloading and overriding, the self keyword, subclass re-
sponsibility, is not yet specified, multiple constructors, and
constructor calls within constructors.

• The time expression.

The following language features are not yet supported:

• Lambda expressions.

• Pre-conditions, post-conditions and invariants.

• Products.
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• Quanti�ers.

• For index loops and while loops.

• Type queries on class instances.

• File I/O via the I/O library.

Most importantly, the development of Overture's C code generator is now be-
ing geared toward resource-constrained embedded platforms. Improvements
are currently being made to enable deployment of the generated code on PIC
and ATmega microcontrollers.

8.2 20-sim

20-sim supports ANSI-C and C++ code generation through the usage of
external and user-modi�able code-generation templates. Currently only a
subset of the supported 20-sim modelling language elements can be exported
as ANSI-C or C++ code code. The exact supported features depend on the
chosen template and its purpose and are discussed in Section 5.2.

The main purpose of the 20-sim code generator is to export control systems.
Therefore the focus in on running code on bare-bone targets (e.g. Arduino)
or as a real-time task on a real-time operating system.

The code generated by 20-sim does not contain any target-related or operat-
ing system speci�c code. The exported code is generated such that it can be
embedded in an external software project. For running 20-sim generated code
on a target, you can use 20-sim 4C. This is a tool that extends the 20-sim
generated code with target code based on target templates [Con16].

8.3 OpenModelica

OpenModelica supports code generation from Modelica to source-code tar-
geting both ANSI-C and C++. From the generated source code, co-simulation
and model-exchange FMUs can be built. Currently, the only supported solver
in the generated co-simulation FMUs is forward Euler. Work to support ad-
ditional solvers is underway. The ability to deploy the generated code to
speci�c hardware targets will be supported via 20-sim 4C.
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8.4 RT-Tester/RTT-MBT

When generating test FMUs from SysML discrete-event state-chart speci�-
cations using RTTester/RTT-MBT, the user should be aware of the following
sources of errors:

• Livelock resulting from a transition cycle in the state-chart speci�cation
in which all transition guards are true simultaneously. This can be
checked separately using a livelock checker.

• Race conditions arising from parallel state-charts assigning di�erent
values to the same variable. Model execution in this case will deadlock.

• State-charts specifying a replacement SUT must be deterministic.

9 Issue handling

Should you experience an issue while using one or more of the INTO-CPS
tools, please take the time to report the issue to the INTO-CPS project team,
so we can help you resolve it as soon as possible.

The following three small sub-sections will guide you through the three simple
steps of issue handling and reporting.

9.1 Are you using the newest INTO-CPS release?

Before you go any further with your current issue, please check that the
INTO-CPS version you are using is the newest. The version number is part
of the �le name of the ZIP-bundle of the release. To �nd the list of released
INTO-CPS bundle versions, and to see what the current version of INTO-
CPS is, please visit

https://github.com/into-cps/intocps-ui/releases/

9.2 Has the issue already been reported?

To make it easy for you to check whether the issue you are experiencing is
an already known one, we have created a list of all currently known issues
across all the INTO-CPS tools, with links directly to the online issue report
page of the relevant tool supplier. Have a quick look at the list, and if your
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issue is already known, we recommend you follow the link and read more
about the speci�cs of the issue. Perhaps someone has found a work-around
or perhaps you have new information to add that might help the developers
solve the issue faster.

For the list of currently known issues, please visit

http://into-cps.github.io/weekly-issue/index.html

Note that some of the issue tracker sites might require you to register before
you can view or submit issues. Registration is free.

9.3 Reporting a new issue

If you have followed the steps in the two previous sections and are now
certain that you have spotted a new issue relating to a speci�c INTO-CPS
tool, please visit the issue tracker site for that tool and report it. To ease
this process we have listed direct links for each tool to their relevant online
issue reporting page. To see the list of issue tracker links please visit

http://into-cps.github.io/report-an-issue.html

10 Conclusions

This deliverable is the user manual for the INTO-CPS tool chain after the
second year of the project. The tool chain supports model-based design and
validation of CPSs, with an emphasis on multi-model co-simulation.

Several independent simulation tools are orchestrated by a custom co-simu-
lation orchestration engine, which implements both �xed and variable step
size co-simulation semantics. A multi-model thus co-simulated can be fur-
ther veri�ed through automated model-based testing and bounded model
checking.

The tool chain bene�ts from a cohesive management interface, the INTO-
CPS Application, the main gateway to modelling and validation with the
INTO-CPS technology. Following the manual should give a new user of the
INTO-CPS tool chain an understanding of all the elements of the INTO-CPS
vision for co-simulation. This manual is accompanied by tutorial material
and guidance on the main INTO-CPS tool chain website,

http://into-cps.github.io
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Features that have not yet been fully developed or integrated with the INTO-
CPS Application are currently being addressed and are targeted for the �nal
year of the INTO-CPS project.
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A List of Acronyms

20-sim Software package for modelling and simulation of dynamic systems
API Application Programming Interface
AST Abstract Syntax Tree
AU Aarhus University
BCS Basic Control States
CLE ClearSy
CLP Controllab Products B.V.
COE Co-simulation Orchestration Engine
CORBA Common Object Request Broker Architecture
CPS Cyber-Physical Systems
CT Continuous-Time
DE Discrete Event
DESTECS Design Support and Tooling for Embedded Control Software
DSE Design Space Exploration
FMI Functional Mockup Interface
FMI-Co Functional Mockup Interface � for Co-simulation
FMI-ME Functional Mockup Interface � Model Exchange
FMU Functional Mockup Unit
HiL Hardware-in-the-Loop
HMI Human Machine Interface
HW Hardware
ICT Information Communication Technology
IDE Integrated Design Environment
LTL Linear Temporal Logic
M&S Modelling and Simulation
MARTE Modeling and Analysis of Real-Time and Embedded Systems
MBD Model-based Design
MBT Model-based Testing
MC/DC Modi�ed Decision/Condition Coverage
MDE Model Driven Engineering
MiL Model-in-the-Loop
MIWG Model Interchange Working Group
OMG Object Management Group
OS Operating System
PID Proportional Integral Derivative
PROV-N The Provenance Notation
RPC Remote Procedure Call
RTT Real-Time Tester
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SiL Software-in-the Loop
SMT Satis�ability Modulo Theories
ST Softeam
SUT System Under Test
SVN Subversion
SysML Systems Modelling Language
TA Test Automation
TE Test Environment
TR TRansitions
TRL Technology Readiness Level
TWT TWT GmbH Science & Innovation
UML Uni�ed Modelling Language
UNEW University of Newcastle upon Tyne
UTP Unifying Theories of Programming
UTRC United Technologies Research Center
UY University of York
VDM Vienna Development Method
VSI Veri�ed Systems International
WP Work Package
XML Extensible Markup Language
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B Background on the Individual Tools

This appendix provides background information on each of the independent
tools of the INTO-CPS tool chain.

B.1 Modelio

Modelio is a comprehensive MDE [Fav05] workbench tool which supports
the UML2.x standard. Modelio adds modern Eclipse-based graphical envi-
ronment to the solid modelling and generation know-how obtained with the
earlier Softeam MDE workbench, Objecteering, which has been on the mar-
ket since 1991. Modelio provides a central repository for the local model,
which allows various languages (UML pro�les) to be combined in the same
model, abstraction layers to be managed and traceability between di�erent
model elements to be established. Modelio makes use of extension modules,
enabling the customization of this MDE environment for di�erent purposes
and stakeholders. The XMI module allows models to be exchanged between
di�erent UML modelling tools. Modelio supports the most popular XMI
UML2 �avors, namely EMF UML2 and OMG UML 2.3. Modelio is one of
the leaders in the OMG Model Interchange Working Group (MIWG), due to
continuous work on XMI exchange improvements.

Among the extension modules, some are dedicated to IT system architects.
For system engineering, SysML or MARTE modules can be used. They
provide dedicated modelling support for dealing with general, software and
hardware aspects of embedded or cyber physical systems. In addition, sev-
eral utility modules are available, such as the Document Publisher which
provides comprehensive support for the generation of di�erent types of doc-
ument.

Modelio is highly extendable and can be used as a platform for building
new MDE features. The tool enables users to build UML2 Pro�les, and to
combine them with a rich graphical interface for dedicated diagrams, model
element property editors and action command controls. Users can use several
extension mechanisms: light Python scripts or a rich Java API, both of which
provide access to Modelio`s model repository and graphical interface.
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B.2 Overture

The Overture platform [LBF+10] is an Eclipse-based integrated development
environment (IDE) for the development and validation of system speci�ca-
tions in three dialects of the speci�cation language of the Vienna Develop-
ment Method. Overture is distributed with a suite of examples and step-by-
step tutorials which demonstrate the features of the three dialects. A user
manual for the platform itself is also provided [LLJ+13], which is accessible
through Overture's help system. Although certain features of Overture are
relevant only to the development of software systems, VDM itself can be used
for the speci�cation and validation of any system with distinct states, known
as discrete-event systems, such as physical plants, protocols, controllers (both
mechanical and software) etc., and Overture can be used to aid in validation
activities in each case.

Overture supports the following activities:

• The de�nition and elaboration of syntactically correct speci�cations in
any of the three dialects, via automatic syntax and type validation.

• The inspection and assay of automatically generated proof obligations
which ensure correctness in those aspects of speci�cation validation
which can not be automated.

• Direct interaction with a speci�cation via an execution engine which
can be used on those elements of the speci�cation written in an exe-
cutable subset of the language.

• Automated testing of speci�cations via a custom test suite de�nition
language and execution engine.

• Visualization of test coverage information gathered from automated
testing.

• Visualization of timing behaviours for speci�cations incorporating tim-
ing information.

• Translation to/from UML system representations.

• For speci�cations written in the special executable subset of the lan-
guage, obtaining Java implementations of the speci�ed system auto-
matically.

For more information and tutorials, please refer to the documentation dis-
tributed with Overture.
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The following is a brief introduction to the features of the three dialects of
the VDM speci�cation language.

VDM-SL This is the foundation of the other two dialects. It supports the
development of monolithic state-based speci�cations with state transition
operations. Central to a VDM-SL speci�cation is a de�nition of the state
of the system under development. The meaning of the system and how it
operates is conveyed by means of changes to the state. The nature of the
changes is captured by state-modifying operations. These may make use of
auxiliary functions which do not modify state. The language has the usual
provisions for arithmetic, new dependent types, invariants, pre- and post-
conditions etc. Examples can be found in the VDM-SL tutorials distributed
with Overture.

VDM++ The VDM++ dialect supports a speci�cation style inspired by
object-oriented programming. In this speci�cation paradigm, a system is
understood as being composed of entities which encapsulate both state and
behaviour, and which interact with each other. Entities are de�ned via tem-
plates known as classes. A complete system is de�ned by specifying instances
of the various classes. The instances are independent of each other, and they
may or may not interact with other instances. As in object-oriented program-
ming, the ability of one component to act directly on any other is speci�ed
in the corresponding class as a state element. Interaction is naturally carried
out via precisely de�ned interfaces. Usually a single class is de�ned which
represents the entire system, and it has one instance, but this is only a con-
vention. This class may have additional state elements of its own. Whereas a
system in VDM-SL has a central state which is modi�ed throughout the life-
time of the system, the state of a VDM++ system is distributed among all of
its components. Examples can be found in the VDM++ tutorials distributed
with Overture.

VDM-RT VDM-RT is a small extension to VDM++ which adds two pri-
mary features:

• The ability to de�ne how the speci�ed system is envisioned to be allo-
cated on a distributed execution platform, together with the commu-
nication topology.

• The ability to specify the timing behaviours of individual components,
as well as whether certain behaviours are meant to be cyclical.
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Finer details can be speci�ed, such as execution synchronization and mu-
tual exclusion on shared resources. A VDM-RT speci�cation has the same
structure as a VDM++ speci�cation, only the conventional system class of
VDM++ is mandatory in VDM-RT. Examples can be found in the VDM-RT
tutorials distributed with Overture.

B.3 20-sim

20-sim [Con13, Bro97] is a commercial modelling and simulation software
package for mechatronic systems. With 20-sim, models can be created graph-
ically, similar to drawing an engineering scheme. With these models, the
behaviour of dynamic systems can be analyzed and control systems can be
designed. 20-sim models can be exported as C-code to be run on hardware
for rapid prototyping and HiL-simulation. 20-sim includes tools that allow
an engineer to create models quickly and intuitively. Models can be cre-
ated using equations, block diagrams, physical components and bond graphs
[KR68]. Various tools give support during the model building and simulation.
Other toolboxes help to analyze models, build control systems and improve
system performance. Figure 93 shows 20-sim with a model of a controlled

Figure 93: Example of a hexapod model in 20-sim.

hexapod. The mechanism is generated with the 3D Mechanics Toolbox and
connected with standard actuator and sensor models from the mechanics li-
brary. The hexapod is controlled by PID controllers which are tuned in the
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frequency domain. Everything that is required to build and simulate this
model and generate the controller code for the real system is included inside
the package.

The 20-sim Getting Started manual [KG16] contains examples and step-by-
step tutorials that demonstrate the features of 20-sim. More information on
20-sim can be found at http://www.20sim.com and in the user manual
at http://www.20sim.com/webhelp [KGD16]. The integration of 20-
sim into the INTO-CPS tool-chain is realized via the FMI standard.

B.4 OpenModelica

OpenModelica [Fri04] is an open-source Modelica-based modelling and sim-
ulation environment. Modelica [FE98] is an object-oriented, equation based
language to conveniently model complex physical systems containing, e.g.,
mechanical, electrical, electronic, hydraulic, thermal, control, electric power
or process-oriented subcomponents. The Modelica language (and OpenMod-
elica) supports continuous, discrete and hybrid time simulations. OpenMod-
elica already compiles Modelica models into FMU, C or C++ code for simula-
tion. Several integration solvers, both �xed and variable step size, are avail-
able in OpenModelica: euler, rungekutta, dassl (default), radau5, radau3,
radau1.

OpenModelica can be interfaced to other tools in several ways as described
in the OpenModelica user's manual [Ope]:

• via command line invocation of the omc compiler

• via C API calls to the omc compiler dynamic library

• via the CORBA interface

• via OMPython interface [GFR+12]

OpenModelica has its own scripting language, Modelica script (mos �les),
which can be used to perform actions via the compiler API, such as load-
ing, compilation, simulation of models or plotting of results. OpenModelica
supports Windows, Linux and Mac Os X.

The integration of OpenModelica into the INTO-CPS tool chain is realized
via compliance with the FMI standard, and is described in deliverable D4.1b
[PBLG15].
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B.5 RT-Tester

The RT-Tester [Ver15a] is a test automation tool for automatic test gener-
ation, test execution and real-time test evaluation. Key features include a
strong C/C++-based test script language, high performance multi-threading,
and hard real-time capability. The tool has been successfully applied in avion-
ics, rail automation, and automotive test projects. In the INTO-CPS tool
chain, RT-Tester is responsible for model-based testing, as well as for model
checking. This section gives some background information on the tool from
these two perspectives.

B.5.1 Model-based Testing

The RT-Tester Model Based Test Case and Test Data Generator (RTT-
MBT) [Ver15b] supports model-based testing (MBT), that is, automated
generation of test cases, test data, and test procedures from UML/SysML
models. A number of common modelling tools can be used as front-ends for
this. The most important technical challenge in model-based test automation
is the extraction of test cases from test models. RTT-MBT combines an SMT
solver with a technique akin to bounded model checking so as to extract �nite
paths through the test model according to some prede�ned criterion. This
criterion can, for instance, be MC/DC coverage, or it can be requirements
coverage (if the requirements are speci�ed as temporal logic formulae within
the model). A further aspect is that the environment can be modelled within
the test model. For example, the test model may contain a constraint such
that a certain input to the system-under-test remains in a prede�ned range.
This aspect becomes important once test automation is lifted from single test
models to multi-model cyber-physical systems. The derived test procedures
use the RT-Tester Core as a back-end, allowing the system under test to be
provided on real hardware, software only, or even just simulation to aid test
model development.

Further, RTT-MBT includes requirement tracing from test models down to
test executions and allows for powerful status reporting in large scale testing
projects.

B.5.2 Model Checking of Timed State Charts

RTT-MBT applies model checking to behavioural models that are speci�ed
as timed state charts in UML and SysML, respectively. From these models,
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a transition relation is extracted and represented as an SMT formula in bit-
vector theory [KS08], which is then checked against LTL formulae [Pnu77]
using the algorithm of Biere et al. [BHJ+06]. The standard setting of RTT-
MBT is to apply model checking to a single test model, which consists of the
system speci�cation and an environment.

• A component called TestModel that is annotated with stereotype TE.

• A component called SystemUnderTest that is annotated with stereo-
type SUT.

RTT-MBT uses the stereotypes to infer the role of each component. The in-
teraction between these two parts is implemented via input and output inter-
faces that specify the accessibility of variables using UML stereotypes.

• A variable that is annotated with stereotype SUT2TE is written by
the system model and readable by the environment.

• A variable that is annotated with stereotype TE2SUT is written by
the environment and read by the system model as an input.

A simple example is depicted in Figure 94, which shows a simple composite
structure diagram in Modelio for a turn indication system. The purpose
of the system is to control the lamps of a turn indication system in a car.
Further details are given in [Ver13]. The test model consists of the two
aforementioned components and two interfaces:

• Interface1 is annotated with stereotype TE2SUT and contains three
variables voltage, TurnIndLvr and EmerSwitch. These variables
are controlled by the environment and fed to the system under test as
inputs.

• Interface2 is annotated with stereotype SUT2TE and contains two
variables LampsLeft and LampsRight. These variables are con-
trolled by the system under test and can be read by the environment.

Observe that the two variables LampsLeft and LampsRight have type
int, but should only hold values 0 or 1 to indicate states on or o�. A
straightforward system property that could be veri�ed would thus be that
LampsLeft and LampsRight indeed are only assigned 0 or 1, which could
be expressed by the following LTL speci�cation:

G(0 ≤ LampsLeft ≤ 1 ∧ 0 ≤ LampsRight ≤ 1)

A thorough introduction with more details is given in the RTT-MBT user
manual [Ver13].
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Figure 94: Simple model that highlights interfaces between the environment
and the system-under-test.
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C Underlying Principles

The INTO-CPS tool chain facilitates the design and validation of CPSs
through its implementation of results from a number of underlying principles.
These principles are co-simulation, design space exploration, model-based
test automation and code generation. This appendix provides an introduc-
tion to these concepts.

C.1 Co-simulation

Co-simulation refers to the simultaneous simulation of individual models
which together make up a larger system of interest, for the purpose of ob-
taining a simulation of the larger system. A co-simulation is performed by a
co-simulation orchestration engine. This engine is responsible for initializing
the individual simulations as needed; for selecting correct time step sizes such
that each constituent model can be simulated successfully for that duration,
thus preventing time drift between the constituent simulations; for asking
each individual simulation to perform a simulation step; and for synchro-
nizing information between models as needed after each step. The result of
one such round of simulations is a single simulation step for the complete
multi-model of the system of interest.

As an example, consider a very abstract model of a nuclear power plant. This
consists of a nuclear reactor core, a controller for the reactor, a water and
steam distribution system, a steam-driven turbine and a standard electrical
generator. All these individual components can be modelled separately and
simulated, but when composed into a model of a nuclear power plant, the
outputs of some become the inputs of others. In a co-simulation, outputs
are matched to inputs and each component is simulated one step at a time
in such a way that when each model has performed its simulation step, the
overall result is a simulation step of the complete power plant model. Once
the correct information is exchanged between the constituent models, the
process repeats.

C.2 Design Space Exploration

During the process of developing a CPS, either starting from a completely
blank canvas or constructing a new system from models of existing compo-
nents, the architects will encounter many design decisions that shape the
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�nal product. The activity of investigating and gathering data about the
merits of the di�erent choices available is termed Design Space Exploration.
Some of the choices the designer will face could be described as being the
selection of parameters for speci�c components of the design, such as the
exact position of a sensor, the diameter of wheels or the parameters a�ecting
a control algorithm. Such parameters are variable to some degree and the
selection of their value will a�ect the values of objectives by which a design
will be measured. In these cases it is desirable to explore the di�erent values
each parameter may take and also di�erent combinations of these parameter
values if there are more than one parameter, to �nd a set of designs that best
meets its objectives. However, since the size of the design space is the prod-
uct of the number of parameters and the number of values each may adopt,
it is often impractical to consider performing simulations of all parameter
combinations or to manually assess each design.

The purpose of an automated DSE tool is to help manage the exploration
of the design space, and it separates this problem into three distinct parts:
the search algorithm, obtaining objective values and ranking the designs
according to those objectives. The simplest of all search algorithms is the
exhaustive search, and this algorithm will methodically move through each
design, performing a simulation using each and every one. This is termed
an open loop method, as the simulation results are not considered by the
algorithm at all. Other algorithms, such as a genetic search, where an initial
set of randomly generated individuals are bred to produce increasingly good
results, are closed loop methods. This means that the choice of next design
to be simulated is driven by the results of previous simulations.

Once a simulation has been performed, there are two steps required to close
the loop. The �rst is to analyze the raw results output by the simulation to
determine the value for each of the objectives by which the simulations are
to be judged. Such objective values could simply be the maximum power
consumed by a component or the total distance traveled by an object, but
they could also be more complex measures, such as the proportion of time
a device was operating in the correct mode given some conditions. As well
as numerical objectives, there can also be constraints on the system that
are either passed or failed. Such constraints could be numeric, such as the
maximum power that a substation must never exceed, or they could be based
on temporal logic to check that undesirable events do not occur, such as all
the lights at a road junction not being green at the same time.

The �nal step in a closed loop is to rank the designs according to how well
each performs. The ranking may be trivial, such as in a search for a design
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that minimizes the total amount of energy used, or it may be more complex
if there are multiple objectives to optimize and trade o�. Such ranking
functions can take the form of an equation that returns a score for each
design, where the designs with the highest/lowest scores are considered the
best. Alternatively, if the relationship between the desired objectives is not
well understood, then a Pareto approach can be taken to ranking, where
designs are allocated to ranks of designs that are indistinguishable from each
other, in that each represents an optimum, but there exist di�erent tradeo�s
between the objective values.

C.3 Model-Based Test Automation

The core fragment of test automation activities is a model of the desired
system behaviour, which can be expressed in SysML. This test model in-
duces a transition relation, which describes a collection of execution paths
through the system, where a path is considered a sequence of timed data
vectors (containing internal data, inputs and outputs). The purpose of a test
automation tool is to extract a subset of these paths from the test model
and turn these paths into test cases, respectively test procedures. The test
procedures then compare the behaviour of the actual system-under-test to
the path, and produce warnings once discrepancies are observed.

C.4 Code Generation

Code generation refers to the translation of a modelling language to a com-
mon programming language. Code generation is commonly employed in con-
trol engineering, where a controller is modelled and validated using a tool
such as 20-sim, and �nally translated into source code to be compiled for
some embedded execution platform, which is its �nal destination.

The relationship that must be maintained between the source model and
translated program must be one of re�nement, in the sense that the trans-
lated program must not do anything that is not captured by the original
model. This must be considered when translating models written in high-
level speci�cation languages, such as VDM. The purpose of such languages
is to allow the speci�cation of several equivalent implementations. When
a model written in such a language is translated to code, one such imple-
mentation is essentially chosen. In the process, any non-determinism in the
speci�cation, the speci�cation technique that allows a choice of implemen-
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tations, must be resolved. Usually this choice is made very simple by re-
stricting the modelling language to an executable subset, such that no such
non-determinism is allowed in the model. This restricts the choice of imple-
mentations to very few, often one, which is the one into which the model is
translated via code generation.
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